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Microsoft Excel Beyond the Basics 
Enhancing your proficiency in Excel can substantially increase your productivity and 
efficiency. By mastering advanced functions, PivotTables, and data visualization tools, 
you can convert raw data into comprehensive reports and dashboards. This 
enhancement not only improves your analytical abilities but also positions you as an 
asset in any data-driven organization.  

Named Ranges 
You can use the labels of columns and rows on a worksheet to refer to the cells within 
those columns and rows. Or you can create descriptive names to represent cells, 
ranges of cells, formulas, or constant values. Labels can be used in formulas that refer 
to data on the same worksheet; if you want to represent a range on another worksheet, 
use a name. 

You can also create 3-D names that represent the same cell 
or range of cells across multiple worksheets. 

Guidelines for Names 
• The first character of a name must be a letter, an underscore character (_), or a 

backslash (\). The remaining characters in the name can be letters, numbers, 
periods, and underscore characters. 

• Names cannot be the same as a cell reference, such as Z$100 or R1C1. 
• You can use multiple words in a name, but spaces are not allowed. Underscore 

characters and periods may be used as word separators — for example, 
Sales_Tax or First.Quarter. 

• A name can contain up to 255 characters. If a name defined for a range 
contains more than 253 characters, you cannot select it from the Name box. 

• Names can contain uppercase and lowercase letters. Microsoft Excel does not 
distinguish between uppercase and lowercase characters in names. For 
example, if you have created the name Sales and then create another name 
called SALES in the same workbook, the second name will replace the first 
one. 

Name Manager – Use the Name Manager to create, edit, and delete range names.  The 
Name Manager provides a complete list of range names in the workbook. 
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To Name a Range 

1. Select the cell or range of cells. Click in the name box.  
2. Type the name. Press Enter 

Edit or Delete Named Ranges 

Use the Name Manager to create, edit, and delete range names.   
• From the Formulas Tab, in the Defined Names Group, click on Name Manager. 
• Select the named range you want to modify. 
• Make the necessary changes then close when finished. 

Everyday Functions 
The most used functions for all data analysis are IF and LOOKUP functions. 

If Functions 
The IF function is one of the most popular functions in Excel, and it allows you to make 
logical comparisons between a value and what you expect. 

IF Function - Syntax and Usage 

The IF function is one of Excel's logical functions that evaluates a certain condition and 
returns the value you specify if the condition is TRUE, and another value if the condition 
is FALSE. 

The syntax for Excel IF is as follows: IF(logical_test, [value_if_true], [value_if_false])  

As you see, the IF function has 3 arguments, but only the first one is obligatory, the 
other two are optional.  

logical_test - a value or logical expression that can be either TRUE or FALSE. 
Required. In this argument, you can specify a text value, date, number, or any 
comparison operator. For example, your logical test can be expressed as or B1="sold", 
B1<12/1/2014, B1=10 or B1>10. 

NAME BOX 
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value_if_true - the value to 
return when the logical test 
evaluates to TRUE, i.e. if the 
condition is met. Optional. For 
example, the following formula 
will return the text "Good" if a 
value in cell B1 is greater than 
10: =IF(B1>10, "Good") 

value_if_false - the value to 
be returned if the logical test 
evaluates to FALSE, i.e. if the condition is not met. Optional. So, an IF statement can 
have two results. The first result is if your comparison is True, the second if your 
comparison is False. For example, =IF(C2=”Yes”,1,2) says IF(C2 = Yes, then return a 1, 
otherwise return a 2).If you need to apply more than one criteria, use the SUMIFS 
function. 

SumIF Function 

The SUMIF function is a worksheet function that adds all numbers in a range of cells 
based on one criteria (for example, is equal to 2000). 
The SUMIF function is a built-in function in Excel that is 
categorized as a Math/Trig Function. As a worksheet 
function, the SUMIF function can be entered as part of a formula in a cell of a 
worksheet. To add numbers in a range based on multiple criteria, try the SUMIFS 
function. 

Using the SUMIF function in financial modeling offers numerous benefits. Firstly, it 
allows users to isolate specific data points and calculate their cumulative values, 
enabling thorough analysis. This functionality is particularly useful when dealing with 
large datasets. 

Secondly, SUMIF provides flexibility in handling conditional calculations. With its ability 
to sum values based on specific criteria, analysts can easily perform calculations for 
different scenarios and parameters. This versatility enhances the accuracy of financial 
models and enables users to make informed decisions based on various conditions. 
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=SUMIF(range, criteria, [sum_range]) 
• The range parameter is actually the range of cells that will be evaluated by the 

‘criteria’ parameter. 
• The criteria parameter is the condition that must be met in the range 

parameter. For instance, if our range was a column that listed t-shirt color, a 
value like red or white could be our criteria. The criteria value can be text, a 
number, a date, a logical expression, a cell reference, or even another function. 

• The sum_range parameter is optional as noted by the brackets. This simply 
means that if omitted, the sum_range will default to the same cells you chose 
for the ‘range’ parameter.  

Examples of SUMIF 

When using criteria in the SUMIF function, you can enter it manually in the formula or 
have it reference a cell. 

Benefits of referencing a cell is if the criteria will change on a regular basis, you can 
enter the criteria in a cell instead of having to update the formula each time. 

NOTE: The Dept Criteria can also be a data validation drop down list.  
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COUNTIF Function 

The Excel COUNTIF function in the Excel table determines the number of items, based 
on the criterion we provide. The function can be used, as an example, for determining 
the quantity of supplies, stocktaking, etc. The 
manual assumes that we have basic 
knowledge of creating formulas in Excel. 

Use COUNTIF, one of the statistical 
functions, to count the number of cells that 
meet a criterion; for example, to count the 
number of times a particular city appears in a 
customer list. =COUNTIF(Where do you want 
to look?, What do you want to look for?) 

Syntax =COUNTIF(range, criteria)  

AverageIF Function 

AVERAGEIF calculates central tendency, which is the location of the center of a group 
of numbers in a statistical distribution. Returns the average (arithmetic mean) of all the 
cells in a range that meet a given criteria. Syntax =AVERAGEIF(range, criteria, 
[average_range]) 
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Lookup and Reference Functions 

vLookup 

The V in VLOOKUP stands for "Vertical." In Excel, the VLookup function searches for 
value in the left-most column of table_array and returns the value in the same row 
based on the index_number. 
 
Usually lists like this have some sort of unique identifier for each item in the list.  In this 
case, the unique identifier is in the “Item Code” column.  Note:  For the VLOOKUP 
function to work with a database/list, that list must have a column containing the unique 
identifier (or “key”, or “ID”), and that column must be the first column in the table.  Our 
sample database above satisfies this criterion. 
 
The secret to VLOOKUP is to organize your 
data so that the value you look up is to the left 
of the return value you want to find. 
 
The VLOOKUP function syntax has the 
following arguments: 
VLOOKUP (lookup_value, table_array, 
col_index_num, [range_lookup]) 
 
For example: 

=VLOOKUP(105,A2:C7,2,TRUE) 
=VLOOKUP("Fontana",B2:E7,2,FALSE) 

 
lookup_value    (required) 

• The value you want to look up. The value you want to look up must be in the first 
column of the range of cells you specify in table-array. 

• For example, if table-array spans cells B2:D7, then your lookup_value must be in 
column B. See the graphic below. Lookup_value can be a value or a reference to 
a cell. 

 table_array    (required) 
• The range of cells in which the VLOOKUP will search for the lookup_value and 

the return value.  
• The first column in the cell range must contain the lookup_value (for example, 

Last Name in the picture below.) The cell range also needs to include the return 
value (for example, First Name in the graphic below) you want to find. 

col_index_num    (required) 
• The column number (starting with 1 for the left-most column of table-array) that 

contains the return value.  
range_lookup   (optional) 

• A logical value that specifies whether you want VLOOKUP to find an exact match 
or an approximate match: 
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• TRUE assumes the first column in the table is sorted either numerically or 
alphabetically, and will then search for the closest value. This is the default 
method if you don't specify one. 

• FALSE searches for the exact value in the first column.  
 
Best practices 

Do this  Why  
Use absolute references for 
range_lookup 
 

Using absolute references allows you to fill-down a formula so 
that it always looks at the same exact lookup range. 
 

Don't store number or date 
values as text. 
 

When searching number or date values, be sure the data in the 
first column of table_array isn't stored as text values. Otherwise, 
VLOOKUP might return an incorrect or unexpected value.  

Sort the first column Sort the first column of the table_array before using VLOOKUP 
when range_lookup is TRUE. 

Use wildcard characters 
 

If range_lookup is FALSE and lookup_value is text, you can use 
the wildcard characters—the question mark (?) and asterisk (*)—
in lookup_value. A question mark matches any single character. 
An asterisk matches any sequence of characters. If you want to 
find an actual question mark or asterisk, type a tilde (~) in front of 
the character.  

Make sure your data doesn't 
contain erroneous 
characters. 
 

When searching text values in the first column, make sure the 
data in the first column doesn't have leading spaces, trailing 
spaces, inconsistent use of straight ( ' or " ) and curly ( ‘ or “) 
quotation marks, or nonprinting characters. In these cases, 
VLOOKUP might return an unexpected value.  
To get accurate results, try using the CLEAN function or the TRIM 
function to remove trailing spaces after table values in a cell. 

XLookup 

The XLOOKUP function searches a range or an array, and then returns the 
item corresponding to the first match it finds. If no match exists, then XLOOKUP can 
return the closest (approximate) match.  

=XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found], 
[match_mode], [search_mode])  

Argument Description 
lookup_value 
Required* 

The value to search for 
 
*If omitted, XLOOKUP returns blank cells it finds in lookup_array.    

lookup_array 
Required 

The array or range to search 

return_array 
Required 

The array or range to return 

[if_not_found] 
Optional 

Where a valid match is not found, return the [if_not_found] text you 
supply. 
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Argument Description 
If a valid match is not found, and [if_not_found] is missing, #N/A is 
returned. 

[match_mode] 
Optional 

Specify the match type: 
0 - Exact match. If none found, return #N/A. This is the default. 
-1 - Exact match. If none found, return the next smaller item. 
1 - Exact match. If none found, return the next larger item. 
2 - A wildcard match where *, ?, and ~ have special meaning. 

[search_mode] 
Optional 

Specify the search mode to use: 
1 - Perform a search starting at the first item. This is the default. 
-1 - Perform a reverse search starting at the last item. 
2 - Perform a binary search that relies on lookup_array being sorted 
in ascending order. If not sorted, invalid results will be returned. 
-2 - Perform a binary search that relies on lookup_array being sorted 
in descending order. If not sorted, invalid results will be returned. 

XLOOKUP SYNTAX 
We can also explore the full definition for the XLOOKUP function: 

1 XLOOKUP(lookup_value, lookup_array, return_array, [match_mode], 
[search_mode]) 

We already described the first 3 parameters however we also have 2 remaining: 

match_mode – the type of match you want to make. What is interesting is the mode 
2 allowing you to use ? and * wildcards to replace a single or any number of characters 
in a lookup operation 

search_mode – type and direction of search. Useful when there is a particular sorting 
order of data. 

  

https://support.microsoft.com/en-us/office/using-wildcard-characters-in-searches-ef94362e-9999-4350-ad74-4d2371110adb
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Examples 
Example 1    uses XLOOKUP to 
look up a country name in a 
range, and then return its 
telephone country code. It 
includes the lookup_value (cell 
F2), lookup_array (range 
B2:B11), 
and return_array (range 
D2:D11) arguments. It doesn't 
include 
the match_mode argument, as 
XLOOKUP produces an exact 
match by default. 

Note: XLOOKUP uses a lookup array and a return array, whereas VLOOKUP uses a 
single table array followed by a column index number. The equivalent VLOOKUP 
formula in this case would be: =VLOOKUP(F2,B2:D11,3,FALSE) 

Example 2    looks up 
employee information 
based on an 
employee ID number. 
Unlike VLOOKUP, 
XLOOKUP can return 
an array with multiple 
items, so a single 
formula can return 
both employee name 
and department from 
cells C5:D14. 
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Example 3    adds 

an if_not_found argument to the preceding example. 

Both formulas will return the same result. Notice, however, for XLOOKUP we provided 
both the lookup column and the result column separately. While for VLOOKUP we 
needed to provide the whole table and indicate the result column number. The 
additional difference we see is that in XLOOKUP we didn’t have to provide the exact 
match parameter – in XLOOKUP the default is an exact match. 

This makes the XLOOKUP function a combination of INDEX & MATCH functions. The 
VLOOKUP had a lot of issues like having to put the lookup column at the front of the 
table or at least before the result column. 

Xlookup Advantages 
Key differences you should spot in the example above and appreciate if you are used to 
using the VLOOKUP formula: 

• XLOOKUP takes the lookup and result columns separately as arguments 
• For XLOOKUP we don’t need to specify the range_lookup parameter for exact 

matches i.e. True for exact match, False for approximation. This is because 
XLOOKUP assume exact matches by default 

• The XLOOKUP formula is simply shorter 
• Similarly to using the INDEX MATCH combo the XLOOKUP is safer as shifting 

columns will not break your formula 

  



MICROSOFT EXCEL  

aldridge.com   13 

Date Functions 
There are approximately 22 different DATE functions available in Excel. Excel stores 
dates as sequential serial numbers so they can be used in calculations. By default, 
January 1, 1900 is serial number 1, and January 1, 2008 is serial number 39448 
because it is 39,448 days after January 1, 1900. 

The TODAY function is useful when you need to have the current date displayed on a 
worksheet, regardless of when you open the workbook.  It is also useful for calculating 
intervals. For example, if you know that someone was born in 1963, you might use the 
following formula to find that person's age as of this year's birthday: 
=YEAR(TODAY())-1963 
 
This formula uses the TODAY function as an argument for the YEAR function to obtain 
the current year, and then subtracts 1963, returning the person's age. 
 
Date Function Examples: 
 

7/18/1985 18 =DAY(A1) 
 

7 =MONTH(A1) 
 

1985 =YEAR(A1) 

12/25/2012 3 =WEEKDAY(A4) 

1/10/2012 2 =WEEKNUM(A5) 
  

 

Workday Function 
 

 

Completion Date 1/2/2013 =WORKDAY(B11,B12,B13:B15) 
  

 

Start Date 7/1/2012  

Total days needed 130  

Holidays 7/4/2012  
 

11/22/2012  
 

12/25/2012  
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DATE Example: 

 
TODAY Function 

The TODAY function is useful when you need to have the current date displayed on a 
worksheet, regardless of when you open the workbook.  It is also useful for calculating 
intervals. =TODAY() 
 
Example, if you know that someone was born in 1963, you might use the following 
formula to find that person's age as of this year's birthday: =YEAR(TODAY())-1963 
 
This formula uses the TODAY function as an argument for the YEAR function to obtain 
the current year, and then subtracts 1963, returning the person's age. 

• To figure out the number of years between 2 dates: =YEAR(date)-YEAR(date) 
• If you want the difference between a date and “today’s date”:  =TODAY()-(date) 

NETWORKDAYS 

Find the difference between a start and end date but only count the dates Monday thru 
Friday, no weekends. You can also add holidays. 

NETWORKDAYS syntax:  =NETWORKDAYS(start_date, end_date, [holidays]) 
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Flash Fill 
Flash Fill is like a data assistant that finishes your work for you. As soon as it detects 
what you want to do, Flash Fill enters the rest of your data in one fell swoop, following 
the pattern it recognizes in your data. 

Here’s an example: 

1. You have a long list containing huge amounts of data. For example, let’s says it’s the 
names of your customers and their seven-digit phone numbers shown in the Home 
Number column. If you need to make a couple of 
new columns out of this data, you can use Flash 
Fill. If you need to change the format of each 
phone number to 395-6492 instead of 3956492, 
inserting a hyphen in every phone number by 
typing is a lot of work. In previous versions of 
Excel, you could use a formula for that. However, 
Excel 2013 offers an even quicker way of doing it 
by using Flash Fill. 

Type the right format of the first phone number in a new column (e.g. 395-6492). Go to 
the next cell of the column and start typing the next phone number. After typing the first 
three digits (722).  

Excel will fill in the format you need for the rest of the phone numbers. All you need to 
do is just press enter, and you will get all phone numbers with a hyphen in that column. 
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Sorting and Filtering Data 
Sorting Data 

Sorting data in Excel allows you to arrange your data in a specific order. You can sort 
data alphabetically, numerically, or by date, either in ascending or descending order. 
For example, you might sort a list of names from A to Z or a list of sales figures from 
highest to lowest. This helps in organizing and analyzing your data more effectively. 

Filtering Data 

Filtering data in Excel enables you to display only the rows that meet certain criteria 
while hiding the others. This is useful when you want to focus on specific information 
within a large dataset. For instance, you can filter a list of products to show only those 
that are in stock or filter sales data to display only transactions from a particular region. 

Custom Sort 

1. Select a range of cells with two or more columns of data, or make sure that the 
active cell is in a table with two or more columns.  

2. On the Home tab, in the Editing group, click Sort & Filter, and then click Custom 
Sort.  

3. The Sort dialog box is displayed.  
4. Under Column, in the Sort by box, select the first column that you want to sort.  
5. Under Sort On, select the type of sort. Do one of the following:  

• To sort by text, number, or date and time, select Values.  
• To sort by format, select Cell Color, Font Color, or Cell Icon. 

6. Under Order, select how you want to sort. Do one of the following:  
• For text values, select A to Z or Z to A.  
• For number values, select Smallest to Largest or Largest to Smallest.  
• For date or time values, select Oldest to Newest or Newest to Oldest.  
• To sort based on a custom list, select Custom List. 
• To add another column to sort by, click Add Level, and then repeat steps 

three through five.  
7. To copy a column to sort by, select the entry, and then click Copy Level.  
8. To delete a column to sort by, select the entry, and then click Delete Level.  

To change the order in which the columns are sorted, select an entry, and then click the 
Up or Down arrow to change the order.  Entries higher in the list are sorted before 
entries lower in the list. 
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Filtering 
If your worksheet contains a lot of content, it can be difficult to find information quickly. 
Filters can be used to narrow down the data in your worksheet, allowing you to view 
only the information you need. 

Do one of the following:  

1. Select a range of cells containing alphanumeric data.  
2. On the Home tab, in the Editing group, click Sort & Filter, and then click Filter.  

The list of text values can be up to 10,000. If the list is large, clear (Select All) at the top, 
and then select the specific text values to filter by.  

Use the down arrow to the right of each column heading to display a unique list of items 
found in the column.  If you only want to see specific records (rows) of information you 
can unselect all items and select only the items you want to display. 

When a filter is applied to a column you will see the down arrow with a filter icon for that 
column. 

To remove a filter from a column, click on the down arrow for that column then click on. 
Subtotal Function 
The Subtotal function returns a subtotal in a list or database. It is generally easier to 
create a list with subtotals by using the Subtotal command in the Outline group on the 
Data tab in the Excel desktop 
application. Once the subtotal list 
is created, you can modify it by 
editing the SUBTOTAL function. 

Syntax 

=SUBTOTAL(function_num,ref1,[ref2],...) 

The SUBTOTAL function syntax has the following arguments: 

Function_num     Required. The number 1-11 or 101-111 that specifies the function to 
use for the subtotal. 1-11 includes manually-hidden rows, while 101-111 excludes them; 
filtered-out cells are always excluded. 

Function_num  
(includes hidden values)  

Function_num  
(ignores hidden values)  

Function  

1 101 AVERAGE 
2 102 COUNT 
3 103 COUNTA 
4 104 MAX 
5 105 MIN 
6 106 PRODUCT 
7 107 STDEV 
8 108 STDEVP 
9 109 SUM 
10 110 VAR 
11 111 VARP 
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Using Excel Tables 
To make managing and analyzing a group of related data easier, you can turn a range 
of cells into a Microsoft Excel table (previously known as an Excel list). A table typically 
contains related data in a series of worksheet rows and columns that have been 
formatted as a table. By using the table features, you can then manage the data in the 
table rows and columns independently from the data in 
other rows and columns on the worksheet. 
 
Note:   Excel tables should not be confused with the data 
tables (data table: A range of cells that shows the results of 
substituting different values in one or more formulas. There 
are two types of data tables: one-input tables and two-input 
tables.) that are part of a suite of what-if analysis 
commands.  
 
To Apply a Table: 

1. Click inside the data range. 
2. From the Home Tab in the Styles Group click on Format as Table. 
3. Click on one of the preformatted options. 
4. Use the Table Tools to make changes to the Table. 

 
Sorting and filtering  
Filter drop-down lists (drop-down list box: A control on a menu, toolbar, or dialog box that displays a 
list of options when you click the small arrow next to the list box.) are automatically added in the 
header row of a table.  

Formatting table data   
You can quickly format table data by applying a predefined or custom table style. You 
can also choose Table Styles options to display a table with or without a header or a 
totals row, to apply row or column banding to make a table easier to read, or to 
distinguish between the first or last columns and other columns in the table.  

  

javascript:AppendPopup(this,'xldefRange_1')
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Formulas Using Table Data 
Calculated columns in Excel tables are a fantastic tool for entering formulas efficiently. 
They allow you to enter a single formula in one cell, and then that formula will 
automatically expand to the rest of the column by itself. There’s no need to use the Fill 
or Copy commands. This can be incredibly time saving, especially if you have a lot of 
rows. And the same thing happens when you change a formula; the change will also 
expand to the rest of the calculated column. 

Note: The screen shots in this article were taken in Excel 2016. If you have a different 
version your view might be slightly different, but unless otherwise noted, the 
functionality is the same. 

Create a calculated column 

1. Insert a new column into the table. You can do this by typing in the column 
immediately to the right of the table, and Excel will automatically extend the table 
for you. In this example, we created a 
new column by typing "Grand Total" 
into cell D1. 

2. Type the formula that you want to use, 
and press Enter. 

In this case we entered =sum(, then selected 
the Qtr 1 and Qtr 2 columns. As a result, 
Excel built the formula: =SUM(Table1[@[Qtr 
1]:[Qtr 2]]). This is called a structured reference formula, which is unique to Excel 
tables. The structured reference format allows the table to use the same formula for 
each row. A regular Excel formula for this would be =SUM(B2:C2), which you would 
then need to copy or fill down to the rest of the cells in your column 

3. When you press Enter, the formula is automatically filled into all cells of the 
column — above as well as below the cell where you entered the formula. The 
formula is the same for each row, but since it's a structured reference, Excel 
knows internally which row is which. 
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Remove a Table 
If you choose to remove the Table features from a range of data you can do so by: 

1. Select the table. 

2. From the Design tab in the Tools Group, click on . 

Excel Charts 
To create a professional-looking chart that displays the details that you want, you can 
modify the chart, apply predefined styles and layouts, and add eye-catching formatting. 
You can also reuse a favorite chart by saving it as a chart template. 
 
To create a Chart: 

1. Select your data. 
2. Go to the Insert Tab and choose one of the Chart 

Types in the Chart Group. 
3. Once your chart has been created you now can use contextual tools for 

formatting the chart. 
 
NOTE: F11 is the keyboard shortcut to creating a chart. 
Recommended Charts 
With Chart recommendations, 
Excel recommends the most 
suitable charts for your data. 
Get a quick peek to see how 
your data looks in the different 
charts, and then simply pick the 
one that shows the insights you 
want to present.  

The Recommended Charts 
button on the Insert tab lets you 
pick from a variety of charts that 
are right for your data. Related 
types of charts like scatter and 
bubble charts are under one 
umbrella. And there’s a brand-
new button for combo charts—a 
favorite chart you’ve asked for. 
When you click a chart, you’ll 
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also see a simpler Chart Tools ribbon. With just a Design and Format tab, it should be 
easier to find what you need. 

Add Chart Elements 
Three chart buttons let you quickly pick and preview changes to chart elements (like 
titles or labels), the look and style of your chart, or to the data that is shown.  

You can include rich and refreshable text from data points or any other text in your data 
labels, enhance them with formatting and additional freeform text, and display them in 
just about any shape. Data labels stay in place, even when you switch to a different type 
of chart. You can also connect them to their data points with leader lines on all charts, 
not just pie charts.  

Chart Tools 
From the Ribbon when you are selected on a Chart you will have Chart Tools available. 
There are 2 tabs for the Chart Tools – Design and Format.  

 
On the Design Tab you will find the following Groups: 

Chart layouts group 
• Add chart element 
• Quick layout 

Chart styles group 
• Change colors 
• Chart styles 

Data group 
• Switch row/column 
• Select data 

Type group 
• Change chart type 

Location group 
• Move chart 
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